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Paper Set 1 · 10 Jun 2026 · 12:30 PM - 2:00 PM · OSSSC CRE 2025 (Odia)

Quant

✓

Q1 Quant
ଏକ ଷ୍ଟୋର ଏକ ସାମଗ୍ରୀ  ଉପରେ "ଗୋଟି ଏ କି ଣନ୍ତୁ ଏବଂ ଆଉ ଗୋଟି ଏ 45% ରି ହାତି ରେ
ପାଆନ୍ତୁ" ସ୍କି ମ ପ୍ର ଦାନ କରେ । ଯଦି  ଏକ ସାମଗ୍ରୀ ର ଚି ହ୍ନି ତ ମୂ ଲ୍ୟ ₹800 ହୁ ଏ, ତେବେ ଜଣେ
ଗ୍ରା ହକ ଦୁ ଇଟି  ସାମଗ୍ରୀ  ପାଇଁ  କେତେ ଦେବେ?

A.  B. ₹1,200

B.  D. ₹1,220

C.  C. ₹1,240

D.  A. ₹1,280

✓

Q2 Quant
If the cost of 7 metres of cloth is ₹315, find the cost of 2.5 metres of
the same cloth.

A.  C. ₹100

B.  D. ₹105.50

C.  A. ₹110.25

D.  B. ₹112.50

✓

Q3 Quant
ଦୁ ଇଟି  ଟ୍ରେ ନ A ଏବଂ B ସମାନ୍ତର ଟ୍ରା କରେ ବି ପରୀତ ଦି ଗରେ ଗତି  କରୁ ଛନ୍ତି  । 180 m
ଦୈ ର୍ଘ୍ୟ  ବି ଶି ଷ୍ଟ ଟ୍ରେ ନ A 54 km/hr ବେଗରେ ଗତି  କରୁ ଥି ବା ବେଳେ 120 m ଦୈ ର୍ଘ୍ୟ
ବି ଶି ଷ୍ଟ ଟ୍ରେ ନ B 36 km/hr ବେଗରେ ଗତି  କରୁ ଛି  । ପ୍ଲା ଟଫର୍ମ ରେ ଠି ଆ ହୋଇଥି ବା ଜଣେ
ବ୍ୟକ୍ତି ଙ୍କୁ  ଅତି କ୍ର ମ କରି ବା ପାଇଁ  ଦ୍ରୁ ତତମ ଟ୍ରେ ନ (A) ନେଇଥି ବା ସମୟ ନି ର୍ଣ୍ଣ ୟ କର ।

A.  A. 10 ସେକେଣ୍ଡ

B.  D. 12 ସେକେଣ୍ଡ

C.  B. 14 ସେକେଣ୍ଡ

D.  C. 15 ସେକେଣ୍ଡ

✓

Q4 Quant
A quadrilateral ABCD has sides such that AB=DC and BC=DA. If its
diagonal intersects at right angle, what is the type of quadrilateral
ABCD?

A.  A. Rectangle

B.  C. Kite

C.  B. Rhombus

D.  D. Square

✓

Q5 Quant
A, B, and C can paint a house in 20 days, 30 days, and 60 days,
respectively. If all three work together, in how many days will the
house be painted completely?

A.  8 days

B.  10 days

C.  12 days

D.  15 days

✓

Q6 Quant
ଯଦି  16 ଜଣ ଶ୍ର ମି କ ଗୋଟି ଏ କାର୍ଯ୍ୟ କୁ  2x ଦି ନରେ (x > 0) ଶେଷ କରି ପାରି ବେ, ତେବେ 8
ଜଣ ଶ୍ର ମି କ କାର୍ଯ୍ୟ ଟି କୁ  ଶେଷ କରି ବା ପାଇଁ  କେତେ ଦି ନ ନେବେ?

A.  x ଦି ନ

B.  2x ଦି ନ

C.  4x ଦି ନ

D.  3x ଦି ନ

✓

Q7 Quant
Find the mode of the given data (rounded off to two decimal places).

Class interval 0-6 6-12 12-18

Frequency 4 6 8

A.  C. 10.64

B.  B. 11.38

C.  D. 12.69

D.  A. 13.71

✓

Q8 Quant
The average age of 35 students of a class is 14 years. When the age
of the class teacher is included, the average becomes 15 years. What
is the age of the class teacher?

A.  A. 40 years

B.  B. 45 years

C.  D. 48 years

D.  C. 50 years
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✓

Q9 Quant
ରାଜୀବ ଏବଂ ସଚି ନ ଯଥାକ୍ର ମେ ₹240 ଏବଂ ₹120 ନି ବେଶ କରି  ଏକ ବ୍ୟବସାୟ ଆରମ୍ଭ
କଲେ । ଯଦି  ସେମାନଙ୍କ ଦ୍ୱାରା ଅର୍ଜିତ ଲାଭରେ ସଚି ନଙ୍କ ଭାଗ ₹930 ହୁ ଏ, ତେବେ
ସେମାନଙ୍କ ଦ୍ୱାରା ଅର୍ଜିତ ମୋଟ ଲାଭ (₹ ରେ) କେତେ ଅଟେ ?

A.  B. 2790

B.  D. 2886

C.  A. 2744

D.  C. 2750

✓

Q10 Quant
X ରୁ  X ର 19% ବି ୟୋଗ କରି ବା X କୁ  __________ ଦ୍ଵାରା ଗୁ ଣନ କରି ବା ସହି ତ ସମାନ
ଅଟେ ।

A.  B. 0.81

B.  D. 0.19

C.  A. 0.5

D.  C. 0.019

✓

Q11 Quant
ଗୋଟି ଏ ପାଇପ 3 ମି ନି ଟରେ ଏକ ଟାଙ୍କି କୁ  ପୂ ର୍ଣ୍ଣ  କରି ପାରି ବ ଯେତେବେଳେକି  ଅନ୍ୟ ଏକ
ପାଇପ ପୂ ର୍ଣ୍ଣ  ଟାଙ୍କି କୁ  12 ମି ନି ଟରେ ଖାଲି  କରି ପାରି ବ । ଯଦି  ଟାଙ୍କି ଟି  ଖାଲି  ଥି ବା ସମୟରେ
ଉଭୟ ପାଇପ ଏକାଠି  ଖୋଲାଯାଏ, ତେବେ ଟାଙ୍କି ର ତି ନି -ଚତୁ ର୍ଥାଂ ଶ ପୂ ର୍ଣ୍ଣ  ହେବାକୁ  କେତେ
ମି ନି ଟ ଲାଗି ବ?

A.  C. 3

B.  B. 6

C.  A. 4

D.  D. 7

✓

Q12 Quant
ଯଦି  △ABC ଓ △RST ପରସ୍ପର ସହ ସଦୃ ଶ ଏବଂ △ABC ର କ୍ଷେତ୍ର ଫଳ, △RST ର
କ୍ଷେତ୍ର ଫଳର ଚାରି ଗୁ ଣ ହୁ ଏ, ଏବଂ AB = 12 cm ହୁ ଏ, ତେବେ RS ର ଦୈ ର୍ଘ୍ୟ  ନି ର୍ଣ୍ଣ ୟ କର ।

A.  B. 6 cm

B.  A. 9 cm

C.  C. 8 cm

D.  D. 3 cm

✓

Q13 Quant
ବାର୍ଷିକ ଭାବେ ଚକ୍ର ବୃ ଦ୍ଧି  ହେଉଥି ବା ବାର୍ଷିକ ଚକ୍ର ବୃ ଦ୍ଧି  ସୁ ଧ ହାରରେ ବି ନି ଯୋଗ କଲେ
ଅଜୟ 4 ବର୍ଷ ରେ ଦୁ ଇଗୁ ଣ ରାଶି  ପାଆନ୍ତି  । କେତେ ବର୍ଷ ରେ ଏହି  ରାଶି  ମୂ ଳରାଶି ର ଷୋହଳ
ଗୁ ଣ ହେବ?

A.  C. 16

B.  A. 8

C.  D. 32

D.  B. 34

✓

Q14 Quant
ଜଣେ ବ୍ୟବସାୟୀ ଚି ହ୍ନି ତ ମୂ ଲ୍ୟ ₹25,000 ଥି ବା ଏକ ଜି ନି ଷକୁ  20% ଓ 5% ର କ୍ର ମାଗତ
ରି ହାତି ରେ କ୍ର ୟ କରନ୍ତି  । ସେ ଏହାର ମରାମତି  ବାବଦରେ ₹1,000 ଖର୍ଚ୍ଚ  କରନ୍ତି  ଏବଂ ଏହାକୁ
₹25,000 ରେ ବି କ୍ରି   କରନ୍ତି  । ତାଙ୍କର ଲାଭ ପ୍ର ତି ଶତ କେତେ ?

A.  C. 20%

B.  D. 25%

C.  A. 15%

D.  B. 10%
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✓

Q15 Quant

A.  

B.  

C.  

D.  

✓

Q16 Quant

A.  A. 114

B.  C. 100

C.  B. 92

D.  D. 90

✓

Q17 Quant

ସମୀକରଣ 4(4x2 - 5) - 4(4x2 + 7x - 7) = 20 କୁ  ସି ଦ୍ଧ କରୁ ଥି ବା x ର ମୂ ଲ୍ୟ ନି ର୍ଣ୍ଣ ୟ କର ।

A.  

B.  

C.  

D.  
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✓

Q18 Quant
ଯଦି  ଏକ କାର 50 km ଦୂ ରତାକୁ  30 km/h ବେଗରେ, 80 km ଦୂ ରତାକୁ  40 km/h ବେଗରେ ଏବଂ 70 km ଦୂ ରତାକୁ  35 km/h ବେଗରେ ଅତି କ୍ର ମ କରେ, ତେବେ ହାରାହାରି  ବେଗ
(km/h ରେ) କେତେ ହେବ?

A.  

B.  

C.  

D.  

✓

Q19 Quant

A.  C. 28%

B.  A. 30%

C.  B. 32%

D.  D. 34%

✓

Q20 Quant
ଦୁ ଇ ଜଣ ପାର୍ଟ ନର ଏକ ବ୍ୟବସାୟରେ ଯଥାକ୍ର ମେ ₹12,500 ଏବଂ ₹8,500 ନି ବେଶ କରନ୍ତି  । ସେମାନଙ୍କ ସମ୍ମତି  କ୍ର ମେ ଲାଭର 60% ସେମାନଙ୍କ ମଧ୍ୟରେ ସମାନ ଭାବରେ ଭାଗ ହେବ ଏବଂ
ଲାଭର ଅବଶି ଷ୍ଟ 40% ସେମାନଙ୍କ ପୁ ଞ୍ଜି ର ଅନୁ ପାତରେ ଭାଗ ହେବ । ଯଦି  ଅଧି କ ନି ବେଶ କରି ଥି ବା ଅଂଶୀଦାର ଅନ୍ୟ ଅଂଶୀଦାରଙ୍କ ଅପେକ୍ଷା ₹600 ଅଧି କ ପାଆନ୍ତି , ତେବେ ବ୍ୟବସାୟରେ
ହୋଇଥି ବା ମୋଟ ଲାଭର ପରି ମାଣ କେତେ?

A.  

B.  

C.  

D.  
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GA

✓

Q21 GA
କୃ ତ୍ରି  ମ ବୃ କକ (Artificial kidney) ଡାଏଲି ସି ସ (dialysis) ମାଧ୍ୟମରେ ରକ୍ତରୁ
ନାଇଟ୍ରୋ ଜେନଯୁ କ୍ତ ବର୍ଜ୍ୟ ବସ୍ତୁକୁ  ବାହାର କରି ବା ପାଇଁ  ଏକ ଯନ୍ତ୍ର ଅଟେ । ଏଥି ରେ _________
ରହି ଥାଏ ।

A.  C. ଏକ ରକ୍ତ ଭଣ୍ଡାର ଏବଂ ଶୀତଳ ପ୍ର ଣାଳୀ (a blood reservoir and
cooling system)

B.  B. ଏକ ନେଫ୍ର ନ-ଅନୁ କରଣକାରୀ ମାଇକ୍ରୋ ଚି ପ (a nephron-mimicking
microchip)

C.  D. ବୃ କକ ଧମନୀ ଏବଂ ବୃ କକ ଶି ରା (renal artery and renal vein)

D.  A. ଅର୍ଦ୍ଧ -ପାରଗମ୍ୟ ଝି ଲ୍ଲୀ ବି ଶି ଷ୍ଟ ଏକ ଡାଏଲାଇଜର (a dialyzer with a
semi-permeable membrane)

✓

Q22 GA
Which Indian actor announced the launch of his fourth book titled
'Different but No Less' in September 2025?

A.  C. Naseeruddin Shah

B.  B. Shah Rukh Khan

C.  A. Anupam Kher

D.  D. Amitabh Bachchan

✓

Q23 GA
କୁ କା ଆନ୍ଦୋଳନ, ଯାହା ପ୍ରା ରମ୍ଭରେ ଏକ ଧାର୍ମିକ ଶୁ ଦ୍ଧି କରଣ ଆନ୍ଦୋଳନ (purification
movement) ଭାବରେ ଆରମ୍ଭ ହୋଇଥି ଲା, ପରବର୍ତ୍ତୀ  ସମୟରେ ନି ମ୍ନ ଲି ଖି ତ କେଉଁ
ରାଜ୍ୟରେ ଏକ ରାଜନୈ ତି କ ଆନ୍ଦୋଳନରେ ପରି ଣତ ହୋଇଥି ଲା?

A.  C. ପଞ୍ଜାବ

B.  D. ଗୁ ଜୁ ରାଟ

C.  A. ବଙ୍ଗ

D.  B. ମଧ୍ୟପ୍ର ଦେଶ 

✓

Q24 GA
2026 ରେ, କେଉଁ  ମନ୍ତ୍ରଣାଳୟର ନେତୃ ତ୍ୱ ନେଉଥି ବା କେନ୍ଦ୍ର ମନ୍ତ୍ରୀଙ୍କ ଦ୍ୱାରା ଚି ନ୍ତନ ଶି ବୀର
ସମୟରେ NIGRANI ଆପ, ହଜ ରି ଷ୍ଟ ବ୍ୟାଣ୍ଡ (Haj Wrist Band) ଏବଂ AI ଚ୍ୟାଟବଟ
ଲଞ୍ଚ କରାଯାଇଥି ଲା?

A.  C. ଗୃ ହ ମନ୍ତ୍ରଣାଳୟ

B.  D. ସଂଖ୍ୟାଲଘୁ  ବ୍ୟାପାର ମନ୍ତ୍ରଣାଳୟ

C.  A. ପର୍ଯ୍ୟ ଟନ ମନ୍ତ୍ରଣାଳୟ

D.  B. ସାମାଜି କ ନ୍ୟାୟ ଏବଂ ସଶକ୍ତି କରଣ ମନ୍ତ୍ରଣାଳୟ 

✓

Q25 GA
An important characteristic of S-waves (secondary waves) that is
useful for understanding Earth's interior structure is that they can
travel only through which material state?

A.  D. Gaseous materials

B.  A. Liquid materials

C.  C. Solid materials

D.  B. Solid and liquid materials

✓

Q26 GA
ଅକ୍ଟୋବର 2025 ରେ ଓଡ଼ି ଶାର କେଉଁ  ରାଜନେତା ରାଜସ୍ୱ ଆଇନର ସରଳୀକରଣ ଏବଂ
ଜମି ଜମା ସଂକ୍ରା ନ୍ତୀୟ ମାମଲାଗୁ ଡ଼ି କର ଦ୍ରୁ ତ ସମାଧାନ ଉପରେ ଗୁ ରୁ ତ୍ୱାରୋପ କରି  ନାଗରି କ-
ଅନୁ କୂ ଳ ସେବା ପ୍ର ଦାନକୁ  ପ୍ରା ଥମି କତା ଦେବା ପାଇଁ  ରାଜସ୍ୱ ଅଧି କାରୀମାନଙ୍କୁ  ପରାମର୍ଶ
ଦେଇଥି ଲେ?

A.  A. ମୋହନ ଚରଣ ମାଝୀ

B.  C. ସୁ ରେଶ ପୂ ଜାରୀ

C.  B. ପୃ ଥ୍ଵୀ ରାଜ ହରି ଚନ୍ଦନ

D.  D. ଦେଓରଞ୍ଜନ କୁ ମାର ସିଂ ହ

✓

Q27 GA
Which peak holds the record for the greatest height in Odisha?

A.  D. Mahendragiri

B.  A. Malayagiri

C.  C. Gandhamardan

D.  B. Deomali

✓

Q28 GA
Which African nation made history by qualifying for the FIFA World
Cup finals for the first time in 2025 after beating Eswatini 3-0?

A.  A. Cabo Verde

B.  B. Iceland

C.  C. Malta

D.  D. Luxembourg

✓

Q29 GA
ନଭେମ୍ବର 2025 ରେ ଆରମ୍ଭ ହୋଇଥି ବା 'YUVA ଆର୍ଟିଫି ସି ଆଲ ଇଣ୍ଟେଲି ଜେନ୍ସ  ଫର
ALL' କୋର୍ଷ  ର ଅବଧି  କେତେ?

A.  B. 4.5 ଘଣ୍ଟା

B.  A. 5.5 ଘଣ୍ଟା

C.  D. 6.5 ଘଣ୍ଟା

D.  C. 7.5 ଘଣ୍ଟା
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✓

Q30 GA
The Odisha Tourism (Amendment) Policy, 2026, amended which
earlier tourism policy framework of the State?

A.  D. Odisha Tourism Policy, 2016

B.  C. Odisha Tourism Policy, 2022

C.  A. Odisha Ecotourism Policy, 2021

D.  B. Odisha Hospitality Promotion Policy, 2023

✓

Q31 GA
Which of the following best explains the historical significance of
Matanga's Brihaddeshi in the evolution of Indian music forms?

A.  B. It introduced the concept of Sapta Svaras for the first time
in Indian music.

B.  D. It established the dominance of Vedic chanting as the only
form of classical music.

C.  C. It marked the emergence and aesthetic development of
the concept of raga in Indian music.

D.  A. It formalized the division between Hindustani and Carnatic
music systems.

✓

Q32 GA
ଅନନ୍ତ ଦୂ ରତାରେ ଥି ବା କୌଣସି  ବସ୍ତୁର ଏକ ଅବତଳ ଲେନ୍ସ  ଦ୍ଵାରା ପ୍ର ତି ବି ମ୍ବ ସୃ ଷ୍ଟି  ହେଲେ,
ଉକ୍ତ ପ୍ର ତି ବି ମ୍ବର ପ୍ର କୃ ତି  ଏବଂ ଅବସ୍ଥି ତି  କ’ଣ ଅଟେ?

A.  D. ପ୍ର ତି ବି ମ୍ବଟି  ବାସ୍ତବ, ସଳଖ ଏବଂ ଆଲୋକ କେନ୍ଦ୍ରରେ ଗଠି ତ 

B.  C. ପ୍ର ତି ବି ମ୍ବଟି  ଆଭାସୀ, ସଳଖ ଏବଂ ମୁ ଖ୍ୟ ଫୋକସରେ ଗଠି ତ 

C.  B. ପ୍ର ତି ବି ମ୍ବଟି  ଆଭାସୀ, ଓଲଟା, ଏବଂ ଫୋକସ ଦୂ ରତାର ଦୁ ଇଗୁ ଣରେ ଗଠି ତ  

D.  A. ପ୍ର ତି ବି ମ୍ବଟି  ବାସ୍ତବ, ଓଲଟା, ଏବଂ ଫୋକସ ସମତଳରେ ଗଠି ତ 

✓

Q33 GA
ସେମି ନାଲ ରି ପୋର୍ଟ  'ଆୱାର କମନ ଫ୍ୟୁ ଚର' (Our Common Future), 'ଆବଶ୍ୟକତା'
ଧାରଣାକୁ  ସ୍ଥାୟୀ ବି କାଶର କେଉଁ  ଦି ଗ ସହି ତ ସବୁ ଠାରୁ  ନି କଟତର ଭାବରେ ସଂଯୁ କ୍ତ
କରି ଥାଏ?

A.  D. ମୁ ଖ୍ୟ ଲକ୍ଷ୍ୟ ଭାବରେ ବୈ ଷୟି କ ନବସୃ ଜନର ପ୍ରୋ ତ୍ସାହନ

B.  A. ଅର୍ଥ ନୈ ତି କ ପ୍ର ଗତି  ପାଇଁ  ଶି ଳ୍ପ ଉତ୍ପାଦନର ସମ୍ପ୍ରସାରଣ  

C.  B. ସର୍ବୋ ପରି  ଜୈ ବ ବି ବି ଧତାର ସଂରକ୍ଷଣ  

D.  C. ସମସ୍ତଙ୍କ ପାଇଁ  ମୌଳି କ ଆବଶ୍ୟକତା ସୁ ନି ଶ୍ଚି ତ କରି ବା ନି ମନ୍ତେ ସମ୍ବଳର ବଣ୍ଟନ

✓

Q34 GA
The Preamble to the Indian Constitution was adopted on ________.

A.  C. 15-Aug-1947

B.  B. 26-Jan-1950

C.  A. 26-Nov-1949

D.  D. 02-Oct-1948

✓

Q35 GA
ଭାରତର ଉତ୍ତର-ପଶ୍ଚି ମ ଦି ଗରେ କେଉଁ  ପଡ଼ୋଶୀ ଦେଶ ଅବସ୍ଥି ତ, ଯାହା ପଞ୍ଜାବ ଏବଂ
ରାଜସ୍ଥାନ ରାଜ୍ୟ ସହି ତ ସୀମା ବଣ୍ଟନ କରେ?

A.  C. ନେପାଳ

B.  B. ଭୁ ଟାନ

C.  A. ପାକି ସ୍ତାନ

D.  D. ମି ଆଁ ମାର

✓

Q36 GA
Which indicator in the Census of India is calculated as the number of
females per 1000 males in the population?

A.  A. Dependency Ratio

B.  D. Population Density

C.  C. Growth Rate

D.  B. Sex Ratio

✓

Q37 GA
Which classical dance form of India originated in the state of Tamil
Nadu?

A.  B. Kathak

B.  A. Bharatanatyam

C.  D. Kathakali

D.  C. Odissi

✓

Q38 GA
Which term refers to a continuous rise in the general price level?

A.  A. Deflation

B.  B. Inflation

C.  C. Stagflation

D.  D. Recession

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q39 GA
କଟକରେ ଉତ୍କଳ ବ୍ରା ହ୍ମ ସମାଜ (Utkal Brahmo Samaj) କେଉଁ  ମସି ହାରେ ପ୍ର ତି ଷ୍ଠା
ହୋଇଥି ଲା?

A.  C. 1857

B.  A. 1869

C.  B. 1875

D.  D. 1882

✓

Q40 GA
ଦୁ ଇ କି ମ୍ବା ଅଧି କ ମୌଳି କରେ ଗଠି ତ ଏକ ପଦାର୍ଥ  _______ ଅଟେ, ଯାହା ରାସାୟନି କ
ଭାବରେ ପରସ୍ପର ସହି ତ ଏକ ସ୍ଥି ର ଅନୁ ପାତରେ ମି ଶ୍ରି  ତ ହୋଇଥାଏ ।

A.  B. ଯୌଗି କ

B.  D. ମି ଶ୍ର ଣ

C.  A. ପଦାର୍ଥ

D.  C. ଶୁ ଦ୍ଧ ପଦାର୍ଥ

English

✓

Q41 English
Parts of a sentence are given below in jumbled order. Select the option in which the parts are arranged in the correct order to form a
meaningful sentence.

Mother Teresa / one / is / of / of / the / missionaries / our / greatest / time

A.  B. Mother Teresa the greatest is one of missionaries of our time.

B.  A. One of the greatest missionaries is of our time Mother Teresa.

C.  D. Mother Teresa is one of the greatest missionaries of our time.

D.  C. Mother Teresa one of the greatest missionaries is of our time.

✓

Q42 English
Select the correct one-word substitute for the underlined group of words in the given sentence.

He felt low on vitality after the classes.

A.  C. untarnished

B.  A. sluggish

C.  D. energetic

D.  B. knowledgeable
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✓

Q43 English

Read the passage carefully and answer the following questions.

In the history of science, few names are as significant as Marie Curie. She was born in Warsaw, Poland in 1867 and became a highly influential
figure in physics and chemistry due to her strong determination and thirst for knowledge. Marie Curie faced many challenges in her early years,
especially because she was a woman in a field dominated by men. However, she didn't let this discourage her. She excelled in her studies and
eventually went to Paris for further education, where she met Pierre Curie, a fellow scientist who later became her husband and research partner.
Together, the Curies explored the mysterious world of radioactivity and made groundbreaking discoveries, identifying two new elements:
polonium and radium. Marie Curie became the first woman to win a Nobel Prize and later, the first person to win two Nobel Prizes in different
scientific areas. But her contributions went beyond discoveries. She pioneered radiotherapy, using radium to treat cancer.

According to the passage, which two elements were discovered by Marie Curie?

A.  D. rhodium and polonium

B.  B. polonium and radium

C.  A. cobalt and neon

D.  C. sodium and radium

✓

Q44 English
Select the most appropriate antonym of the word 'significant'.

A.  B. negligible

B.  D. accountable

C.  C. comfortable

D.  A. effable

✓

Q45 English
Select the most appropriate tone of the passage.

A.  D. Factual

B.  C. Delightful

C.  A. Blunt

D.  B. Comic

✓

Q46 English
Select the most appropriate title for the passage.

A.  A. Marie Curie: The Quantum Matriarch

B.  B. Marie Curie's Doctoral Thesis

C.  C. The life and legacy of Marie Curie

D.  D. Case Files: Marie Curie

✓

Q47 English
Which of the following statements is not true in the context of the passage?

A.  B. Marie Curie pioneered radiotherapy.

B.  A. She discontinued her research after her husband's death.

C.  C. She did not contribute to advancement of medicine.

D.  D. She faced lots of challenges in her life.

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q48 English
In the following question, a statement is given with highlighted text. You are required to replace the text with the correct proverb given in the
options.

In Sudha Murty's novels, it is often showcased that happiness is better than wealth, and characters are encouraged to value contentment
over riches.

A.  A. a happy heart is better than a full purse

B.  B. a penny saved is a penny earned

C.  D. money makes the mare go

D.  C. money makes the world go around

✓

Q49 English
Read the options carefully and choose the one written in correct passive voice.

A.  A. The opera house was lit up beautifully at night.

B.  B. The festival decorated by the townspeople.

C.  C. The surfers are enjoy the waves.

D.  D. The desert bloom each spring.

✓

Q50 English
Select the option that correctly substitutes the wrong word-segment of the given proverb.

Still mountains run deep.

A.  C. Still waters run deep.

B.  B. Still pictures run deep.

C.  D. Still waterfalls run deep.

D.  A. Still rivers run deep.

✓

Q51 English
Choose the correct option to complete the sentence.
She faced repeated failures; ______, she refused to give up and kept trying harder.

A.  C. certainly

B.  A. nevertheless

C.  D. consequently

D.  B. meanwhile
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✓

Q52 English

A sentence in indirect speech is given below. Complete its correct direct form by choosing the appropriate option.
Indirect:
Ravi said that he was planning to start a new venture.
Direct:
Ravi said, “__________________________.”

A.  B. I am planning to start a new venture

B.  C. I was planning to start a new venture

C.  A. He will be planning to start a new venture

D.  D. I plan to start a new venture now

✓

Q53 English
A sentence divided into different segments has been given. Rearrange the segments to form a coherent sentence.

(P) with her friends
(Q) to the zoo
(R) last weekend
(S) Anu went

A.  C. S Q P R

B.  B. Q P S R

C.  D. P S Q R

D.  A. S R Q P

✓

Q54 English
Select the most appropriate option from the given alternatives to fill in the blank.

This time next week, we _____ on the beach enjoying our holiday.

A.  B. will be lying

B.  C. will have lied

C.  A. will lie

D.  D. will be lain

✓

Q55 English
Select the most suitable option to complete the sentence.

The teacher ______ the students to complete their assignments by Friday.

A.  D. instruct

B.  C. have instruct

C.  B. instructing

D.  A. instructed
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✓

Q56 English
Choose the correct antonym of the underlined word in the given sentence.

The government adopted a stringent policy to regulate environmental violations.

A.  A. progressive

B.  C. regressive

C.  D. liberal

D.  B. regulatory

✓

Q57 English
Select the most appropriate article to fill in the blank. If no article is needed, select 'No article required'.

Can you pass me ___ salt on the table?

A.  D. an

B.  C. a

C.  B. the

D.  A. no article required

✓

Q58 English
Choose the word opposite in meaning to the underlined word in the given sentence.

After the scandal, the politician's reputation was tarnished.

A.  D. Cleansed

B.  A. Stained

C.  B. Obscured

D.  C. Poisoned

✓

Q59 English
Select the most appropriate option to substitute the underlined segment in the given sentence.

With the eye of someone who shapes solid forms from materials like metal or stone to represent people or ideas, Paolozzi roamed the scrap
lots and ship-salvage yards of Hamburg, looking for bits of metal.

A.  A. an architect

B.  C. a potter

C.  D. a sculptor

D.  B. a curator

✓

Q60 English
In the given sentence, four words are marked in bold. Choose the word which is wrongly spelt.

The teacher was immensely patient, knowlegeable, and dedicated to her students.

A.  C. immensely

B.  A. patient

C.  B. knowlegeable

D.  D. dedicated
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Odia

✓

Q61 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ପ୍ର ଦୂ ଷଣ ରୋକି ବା ପାଇଁ  ନୂ ତନ ବି ଧି  ଲାଗୁ  ହେବ।

A.  A. A new law will be promoted to stop pollution.

B.  D. New method to stop crime will begin.

C.  B. A new law will be enforced to stop pollution.

D.  C. A new law will be increase to stop pollution.

✓

Q62 Odia
‘ଆକାଶ କୁ ସୁ ମ’ ରୂ ଢି ର ଅର୍ଥ  କ’ଣ?

A.  D. ଆକାଶରେ ଫୁ ଲ ଫୁ ଟି ଛି

B.  A. ଯାହା କେବେ ହେବାର ନାହିଁ

C.  C. ମେଘରୁ  ଫୁ ଲ ଝଡ଼ୁଛି

D.  B. ଆକାଶ ରଙ୍ଗା ଫୁ ଲରେ ଭରତି

✓

Q63 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ସ୍ଵାଧୀନତା ଦି ବସ ପାଳନ ଉପଲକ୍ଷେ ଆମ ସୋସାଇଟି  ରେ ମଧ୍ୟାନ୍ନ ଭୋଜନ ର ବ୍ୟବସ୍ଥା କରାଯାଇଥି ଲା ।

A.  B. A luncheon party was organized in our society during Independence day celebration.

B.  A. On 15th of August, a lunch will be organized in our society.

C.  C. On independence day, lunch was organized.

D.  D. A luncheon party was organized in our society.

✓

Q64 Odia
“ଅଣ୍ଟାରେ ନ ଥାଇ ଧନ, ପୁ ଅ ବାହା କରି  ମନ” ଲୋକବାଣୀର ଅର୍ଥ  କ’ଣ?

A.  B. ଧନହୀନ ଲୋକ ଅଧି କ ଖର୍ଚ୍ଚ  କରି ବାର ଯୋଜନା ହାସ୍ୟାସ୍ପଦ

B.  A. ଧନୀ ଲୋକ ବି ବାହ କରନ୍ତି

C.  C. ବି ବାହରେ ଏତେ ଖର୍ଚ୍ଚ  ଦରକାର ନାହିଁ

D.  D. ଧନହୀନ ଲୋକ ଅଧି କ ଖର୍ଚ୍ଚ  କରେ

✓

Q65 Odia
“ଏକା ଭାଡ଼ି ର ପାରା” ଲୋକବାଣୀର ଅର୍ଥ  କ’ଣ?

A.  B. ଏକାକୀ ଲୋକ

B.  A. ପାରାମାନେ ବାସ କରୁ ଥି ବା ଜାଗା

C.  C. ପାରା ମାନଙ୍କର ବାସସ୍ଥଳୀ

D.  D. ଗୋଟି ଏ ସ୍ୱଭାବର ବ୍ୟକ୍ତି  ବୃ ନ୍ଦ
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✓

Q66 Odia
"ସେ କି ନ୍ତୁ ଏ କଥା ଜାଣି  ନାହାନ୍ତି " - ଏଠାରେ 'କି ନ୍ତୁ' ଯଦି  ବାକ୍ୟର ସୌନ୍ଦର୍ଯ୍ୟ  ପାଇଁ  ବ୍ୟବହୃ ତ ହୋଇଥାଏ, ତେବେ ତାକୁ  କେଉଁ  ଅବ୍ୟୟ କୁ ହାଯି ବ?

A.  D. ସଂଯୋଜକ

B.  B. ଆଳଙ୍କାରି କ

C.  A. ବି ଶେଷଣର ବି ଶେଷଣ

D.  C. ସମ୍ବୋଧନ ସୂ ଚକ

✓

Q67 Odia
'ହରି  କାମଟି  ତରତର ହୋଇ କରୁ ଛି ' ଏଠାରେ 'ତରତର' କେଉଁ  ଶ୍ରେ ଣୀର ଅନ୍ତର୍ଭୁ କ୍ତ?

A.  D. ଗୁ ଣବାଚକ ବି ଶେଷଣ

B.  C. କ୍ରି  ୟା ବି ଶେଷଣ

C.  A. ସର୍ବ ନାମ

D.  B. କ୍ରି  ୟାଜ ବି ଶେଷଣ

✓

Q68 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  ସମୟସୂ ଚକ ଅବ୍ୟୟ କେଉଁ ଟି  ?

A.  C. ଏଠାରେ

B.  B. ଏବେ

C.  A. ବହୁ ତ

D.  D. କି ନ୍ତୁ

✓

Q69 Odia
ନି ମ୍ନ ଲି ଖି ତ ବାକ୍ୟଗୁ ଡି କରେ ଭୁ ଲ ବନାନ ଚି ହ୍ନଟ କରି  ଠି କ୍  ବାକ୍ୟ ବାଛ ।

A.  C. ରାତି ରେ ଗ୍ରା ମଟି  ବହୁ ତ ନୀର୍ଜ ନ ଲାଗୁ ଥି ଲା ।

B.  D. ରାତି ରେ ଗ୍ରା ମଟି  ବହୁ ତ ନି ର୍ଜ ନ ଲାଗୁ ଥି ଲା ।

C.  A. ରାତି ରେ ଗ୍ରା ମଟି  ବହୁ ତ ନି ର୍ଯ ନ ଲାଗୁ ଥି ଲା ।

D.  B. ରାତି ରେ ଗ୍ରା ମଟି  ବହୁ ତ ନୀର୍ଯ ନ ଲାଗୁ ଥି ଲା ।

✓

Q70 Odia
"Fortune favors the brave." - ଏହାର ପ୍ରା ସଙ୍ଗି କ ଓଡ଼ି ଆ ଅନୁ ବାଦ କେଉଁ ଟି ?

A.  D. ଭାଗ୍ୟ ସାହସୀଙ୍କୁ  ସାହାଯ୍ୟ କରେ ।

B.  A. ସାହସୀ ଲୋକ ଭାଗ୍ୟବାନ ।

C.  B. ଭାଗ୍ୟବାନ ଲୋକ ସାହସୀ ହୁ ଅନ୍ତି  ।

D.  C. ସାହସ ଥି ଲେ ଭାଗ୍ୟ ବଦଳେ ।
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✓

Q71 Odia

ପ୍ର ଦତ୍ତ ଅନୁ ଚ୍ଛେଦ ଆଧାରରେ ନି ମ୍ନ ଲି ଖି ତ ପ୍ର ଶ୍ନ ର ସଠି କ ଉତ୍ତର ବାଛ |
ଗତ ଶନି ବାର ଦି ନ, ଆମ ଶ୍ରେ ଣୀର ସମସ୍ତ ଛାତ୍ର ଛାତ୍ରୀ  ମି ଶି  ସହରରେ ଅବସ୍ଥି ତ ଏକ ପ୍ର ସି ଦ୍ଧ ତଥା ଐତି ହାସି କ ସଂଗ୍ର ହାଳୟ ପରି ଦର୍ଶ ନ କରି ବାକୁ  ଯାଇଥି ଲୁ । ସେହି  ସଂଗ୍ର ହାଳୟ ମଧ୍ୟରେ ସଂରକ୍ଷି ତ
ହୋଇ ରହି ଥି ବା ବି ଭି ନ୍ନ ପ୍ରା ଚୀନ କଳାକୃ ତି , ମୂ ଲ୍ୟବାନ ହାତଲେଖା ପାଣ୍ଡୁଲି ପି  ଏବଂ ଅତି  ସୁ ନ୍ଦର ଭାସ୍କର୍ଯ୍ୟ ଗୁ ଡ଼ି କ ଆମକୁ  ଶତାବ୍ଦୀ ଶତାବ୍ଦୀ ପୂ ର୍ବ ରୁ  ବସବାସ କରୁ ଥି ବା ଲୋକମାନଙ୍କର ସାମାଜି କ
ଜୀବନଶୈ ଳୀ, ସଂସ୍କୃତି  ଓ ଚଳଣି  ବି ଷୟରେ ଏକ ସ୍ପଷ୍ଟ ଏବଂ ସୁ ନ୍ଦର ଝଲକ ପ୍ର ଦାନ କରି ଥି ଲା। ଏହି  ଜ୍ଞାନବର୍ଦ୍ଧ କ ପରି ଦର୍ଶ ନ ମାଧ୍ୟମରେ ଆମେ ଆମର ପୁ ରାତନ ପାରମ୍ପରି କ ରୀତି ନୀତି , ବି ଭି ନ୍ନ
ଶୈ ଳୀର ଚି ତ୍ତାକର୍ଷ କ କଳା ରୂ ପ ଏବଂ ଅତୀତର ଅନେକ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ଐତି ହାସି କ ଘଟଣାବଳୀ ବି ଷୟରେ ବହୁ ତ କି ଛି  ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ତଥ୍ୟ ଶି ଖି ବାକୁ  ଏବଂ ବୁ ଝି ବାକୁ  ପାଇଲୁ । ଏହା ବ୍ୟତୀତ, ସଂଗ୍ର ହାଳୟ
ପରି ସର ମଧ୍ୟରେ କି ଛି  ବି ଶେଷ ପ୍ର କାରର ପାରସ୍ପରି କ କ୍ରି  ୟାଶୀଳ ପ୍ର ଦର୍ଶ ନୀର ମଧ୍ୟ ବ୍ୟବସ୍ଥା କରାଯାଇଥି ଲା। ସେହି  ସ୍ଥାନରେ ଆମ ଶ୍ରେ ଣୀର ଛାତ୍ର ଛାତ୍ରୀ ମାନେ ନି ଜେ ପୁ ରାତନ କାଳର ବି ଭି ନ୍ନ
ଲି ପି ରେ ଲେଖି ବା ପାଇଁ  ଚେଷ୍ଟା କରି ଥି ଲେ ଏବଂ ପ୍ରା ଚୀନ କାଳର କି ଛି  ପ୍ର ସି ଦ୍ଧ ଚି ତ୍ର ଗୁ ଡ଼ି କର ସଫଳତାର ସହ ପୁ ନଃ ନି ର୍ମା ଣ କରି ବାର ଏକ ଅପୂ ର୍ବ  ତଥା ରୋମାଞ୍ଚକର ଅନୁ ଭୂ ତି  ହାସଲ କରି ପାରି ଥି ଲେ।
ପ୍ର କୃ ତରେ କହି ବାକୁ  ଗଲେ, ଏହି  ଶି କ୍ଷଣୀୟ ଯାତ୍ରା ଟି  ବହି  ପୃ ଷ୍ଠାରେ ଥି ବା ନି ରସ ଇତି ହାସକୁ  ଆମ ସମସ୍ତଙ୍କ ସାମ୍ନା ରେ ସମ୍ପୂ ର୍ଣ୍ଣ  ରୂ ପେ ଜୀବନ୍ତ ଏବଂ ବାସ୍ତବ କରି ଦେଇଥି ଲା। ଏହି  ସ୍ମରଣୀୟ ଅନୁ ଭୂ ତି  ଆମ
ଶ୍ରେ ଣୀର ଅନେକ ଛାତ୍ର ଛାତ୍ରୀ ଙ୍କ ମନରେ ଏକ ଗଭୀର ରେଖାପାତ କରି ଥି ଲା ଏବଂ ନି ଜର ସମୃ ଦ୍ଧ ଐତି ହ୍ୟ ତଥା ଗୌରବମୟ ଇତି ହାସ ବି ଷୟରେ ଅଧି କରୁ  ଅଧି କ ଗବେଷଣା ଏବଂ ଅନୁ ସନ୍ଧାନ କରି ବା
ପାଇଁ  ସମସ୍ତଙ୍କୁ  ବହୁ ତ ଅନୁ ପ୍ରା ଣି ତ ଓ ଉତ୍ସାହି ତ କରି ଥି ଲା।

ଅତୀତ ବି ଷୟରେ ଜାଣି ବା ପାଇଁ  ଛାତ୍ର ମାନେ କେଉଁ  ପ୍ର କାରର ସାମଗ୍ରୀ  ଦେଖି ଲେ?

A.  D. ଆଧୁ ନି କ ପ୍ର ଯୁ କ୍ତି ବି ଦ୍ୟା ଏବଂ ଗ୍ୟାଜେଟ୍

B.  C. ଜୀବନ୍ତ ପଶୁ  ଏବଂ ଉଦ୍ଭି ଦ

C.  A. ପ୍ରା ଚୀନ କଳାକୃ ତି , ପାଣ୍ଡୁଲି ପି  ଏବଂ ଭାସ୍କର୍ଯ୍ୟ

D.  B. ମହାକାଶ ଉପକରଣ ଏବଂ ଦୂ ରବୀକ୍ଷଣ ଯନ୍ତ୍ର

✓

Q72 Odia
ଗତ ଶନି ବାର ଶ୍ରେ ଣୀ କେଉଁ ଠାକୁ  ଯାଇଥି ଲା?

A.  C. ଏକ ବି ଜ୍ଞାନ କେନ୍ଦ୍ର

B.  A. ଏକ ଐତି ହାସି କ ସଂଗ୍ର ହାଳୟ

C.  B. ଏକ କଳା ଗ୍ୟାଲେରୀ

D.  D. ଏକ ଉଦ୍ଭି ଦ ଉଦ୍ୟାନ

✓

Q73 Odia
ପାରସ୍ପରି କ କ୍ରି  ୟାଶୀଳ ପ୍ର ଦର୍ଶ ନୀର ଏକ ସ୍ୱତନ୍ତ୍ର ବୈ ଶି ଷ୍ଟ୍ୟ କଣ ଥି ଲା?

A.  B. ଭବି ଷ୍ୟତ ବି ଷୟରେ 3D ଚଳଚ୍ଚି ତ୍ର  ଦେଖି ବା

B.  C. ଭି ଡି ଓ ଗେମ୍  ଖେଳି ବା

C.  D. ପୁ ରାତନ ଲି ପି ରେ ଲେଖି ବା ଏବଂ ପ୍ରା ଚୀନ ଚି ତ୍ର ର ପୁ ନଃ ନି ର୍ମା ଣ କରି ବା

D.  A. ଆଧୁ ନି କ ପପ୍  ସଙ୍ଗୀତ ଶୁ ଣି ବା
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✓

Q74 Odia
ସଂଗ୍ର ହାଳୟ ପରି ଦର୍ଶ ନର ଛାତ୍ର ମାନଙ୍କ ଉପରେ ସାମଗ୍ରି  କ ପ୍ର ଭାବ କଣ ଥି ଲା?

A.  B. ଏହା ସେମାନଙ୍କୁ  ବି ରକ୍ତ ଏବଂ କ୍ଲା ନ୍ତ କରି ଦେଲା

B.  A. ଏହା ଇତି ହାସକୁ  ଜୀବନ୍ତ କରି ଦେଲା ଏବଂ ସେମାନଙ୍କୁ  ନି ଜ ଐତି ହ୍ୟ ଅନୁ ସନ୍ଧାନ କରି ବାକୁ  ଅନୁ ପ୍ରା ଣି ତ କଲା

C.  C. ଏହା ସେମାନଙ୍କୁ  ବି ଜ୍ଞାନ ପଢି ବାକୁ  ଆଗ୍ର ହୀ କଲା

D.  D. ଏହା ସେମାନଙ୍କୁ  ଶ୍ରେ ଣୀରେ ଯାହା ଶି ଖି ଥି ଲେ ତାହା ଭୁ ଲାଇ ଦେଲା

✓

Q75 Odia
ଅନୁ ଚ୍ଛେଦ ଅନୁ ଯାୟୀ, ଛାତ୍ର ମାନେ କେଉଁ  ବି ଷୟରେ ଶି ଖି ଲେ?

A.  A. ଗଣି ତ ସୂ ତ୍ର  ଏବଂ ସମୀକରଣ

B.  D. ପାରମ୍ପରି କ ରୀତି ନୀତି , କଳା ରୂ ପ ଏବଂ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ଐତି ହାସି କ ଘଟଣା

C.  C. ଆଧୁ ନି କ ଖାଦ୍ୟ ପ୍ର ଣାଳୀ କି ପରି  ରନ୍ଧାଯାଏ

D.  B. ସାମ୍ପ୍ରତି କ ରାଜନୈ ତି କ ଖବର

Computer

✓

Q76 Computer
MS ପାୱାରପଏଣ୍ଟର କେଉଁ  ଅପସନ ଆପଣଙ୍କୁ  ଏକ ପ୍ରେ ଜେଣ୍ଟେସନ ସମୟରେ ସ୍ଲା ଇଡ ଶୋ
କି ପରି  ଦେଖାଯାଇଥାଏ ତାହା କଷ୍ଟମାଇଜ କରି ବାକୁ  ଅନୁ ମତି  ଦି ଏ?

A.  B. View → Notes Page

B.  C. Insert → Options

C.  D. Design → Background

D.  A. Slide Show → Set Up Slide Show

✓

Q77 Computer
A student is learning how to manage files in MS Word 2021. Which
statement is True or False regarding file saving and version control?

(i) The AutoSave feature automatically saves changes to the
document every few seconds, but only if the document is stored in
OneDrive or SharePoint.
(ii) Using the Save As command creates a copy of the document, but
the original file remains unaffected and retains its original name.

A.  D. (i) True, (ii) True

B.  A. (i) True, (ii) False

C.  B. (i) False, (ii) True

D.  C. (i) False, (ii) False

✓

Q78 Computer
Match the following Basic PowerPoint Actions (Column A) with
their corresponding Descriptions (Column B) as used in Microsoft
PowerPoint 2021:

Column A –
PowerPoint Action

Column B – Description

1. File → New
a) Saves the current presentation to the
desired location.

2. Ctrl + S
b) Creates a new blank presentation or
opens templates for selection.

3. Slide Sorter View c) Displays miniature versions of all slides to
rearrange their order.

4. F5 Key
d) Starts the slide show from the beginning
in full-screen mode.

A.  A. 1–b, 2–a, 3–c, 4–d

B.  B. 1–a, 2–b, 3–d, 4–c

C.  D. 1–c, 2–b, 3–a, 4–d

D.  C. 1–d, 2–c, 3–b, 4–a

✓

Q79 Computer
WWW ର ପୂ ର୍ଣ୍ଣ  ରୂ ପ କ'ଣ?

A.  A. ୱାର୍ଲ୍ଡ  ୱାଇଡ ୱେବ (World Wide Web)

B.  C. ୱାଇଡ ୱେବ ୱାର୍ଲ୍ଡ  (Wide Web World)

C.  B. ୱେବ ୱାର୍ଲ୍ଡ  ୱାଇଡ (Web World Wide)

D.  D. ୱାର୍ଲ୍ଡ  ୱେବ ୱାଇଡ (World Web Wide)
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✓

Q80 Computer
Which option correctly represents the full form of ROM?

A.  D. Random Operational Memory

B.  C. Read Only Memory

C.  A. Read Operating Module

D.  B. Remote Output Memory

✓

Q81 Computer
Which example correctly pairs system software with application
software?

A.  D. BIOS and Notepad

B.  B. Browser and Mobile App

C.  A. Compiler and Antivirus

D.  C. Firmware and Interpreter

✓

Q82 Computer
Double‑clicking the right border of a column header performs what
action in MS Excel 2021?

A.  B. Sorts data

B.  C. Freezes column

C.  D. AutoFits width to longest entry

D.  A. Deletes column

✓

Q83 Computer
The _____ is used to locate and manage hidden objects on a slide.

A.  B. Format Pane

B.  C. Selection Pane

C.  D. Layers Pane

D.  A. Object Pane

✓

Q84 Computer
କମ୍ପ୍ୟୁ ଟର ହ୍ୟାଙ୍ଗ୍  ହେବା ସମୟରେ କମ୍ପ୍ୟୁ ଟରକୁ  ରି ଫ୍ରେ ସ୍  କରି ବା ପାଇଁ  ସାଧାରଣତଃ କେଉଁ
କମାଣ୍ଡ ବ୍ୟବହାର କରାଯାଏ?

A.  B. ସଟ ଡାଉନ

B.  A. ହାଇବର୍ନେ ସନ୍

C.  C. ରି ଷ୍ଟାର୍ଟ

D.  D. ଲଗ ଅଫ

✓

Q85 Computer
Which of the following is ROM primarily used for?

A.  C. Storing temporary data

B.  B. Storing permanent data such as the computer’s startup
instructions

C.  A. Storing running programs

D.  D. Storing cached web pages

✓

Q86 Computer
In Microsoft Word, what does the shortcut Ctrl + X do?

A.  D. Saves the document

B.  A. Cuts the selected text

C.  C. Copies the selected text

D.  B. Pastes text from the clipboard

✓

Q87 Computer
What is the purpose of using bullets in MS Word?

A.  B. To sort data

B.  D. To highlight text

C.  A. To list unordered items

D.  C. To align text

✓

Q88 Computer
ଏକ ଇମେଲ ଆପ୍ଲି  କେସନରେ, "Reply All" କ୍ଲି  କ କଲେ କ'ଣ ହୁ ଏ?

A.  B. କେବଳ ସେଣ୍ଡରଙ୍କୁ  ରି ପ୍ଲା ଏ ଦି ଏ

B.  C. ଅନ୍ୟମାନଙ୍କୁ  ମେସେଜ ଫର୍ର ୱାର୍ଡ  ହୁ ଏ

C.  A. ଓରି ଜି ନାଲ ଇମେଲରେ ଥି ବା ସେଣ୍ଡର ଏବଂ ଅନ୍ୟମାନଙ୍କୁ  ରି ପ୍ଳାଏ ଦି ଏ

D.  D. ବ୍ଳା ଙ୍କ ମେସେଜ ସେଣ୍ଡ କରେ
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✓

Q89 Computer
What is the purpose of Excel's DROP function?

A.  B. Excludes a specified number of rows or columns from the
start or end of an array

B.  C. Deletes a specified number of rows or columns of an array

C.  A. Rounds a number up to the nearest even integer

D.  D. Returns the logical value false

✓

Q90 Computer
In MS Excel 2021, which method correctly uses the fill handle to
generate a series of sequential dates across cells?

A.  C. Select the first cell with a date → Click and drag the fill
handle across the desired range

B.  A. Select the entire range → Press Ctrl + Enter to auto-fill
sequential dates

C.  B. Type the first and last date in the range → Click AutoSum to
fill in the rest

D.  D. Enter a date → Use the Insert tab to generate a timeline
chart

Reasoning

✓

Q91 Reasoning
ଏକ ନି ର୍ଦ୍ଦିଷ୍ଟ କୋଡ୍  ଭାଷାରେ,
'A & B' ର ଅର୍ଥ  'A B ଙ୍କ ସ୍ତ୍ରୀ ଅଟନ୍ତି '
'A – B' ର ଅର୍ଥ  'A B ଙ୍କ ଭାଇ ଅଟନ୍ତି '
'A + B' ର ଅର୍ଥ  'A B ଙ୍କ ବାପା ଅଟନ୍ତି '
'A # B' ର ଅର୍ଥ  'A B ଙ୍କ ଭଉଣୀ ଅଟନ୍ତି ' ।

ଯଦି  ‘Q + F – J # I & T’ ହୁ ଏ, ତେବେ Q ସମ୍ପର୍କ ରେ T ଙ୍କର କ'ଣ ହେବେ?

A.  B. ସ୍ତ୍ରୀଙ୍କ ବାପା

B.  A. ସ୍ତ୍ରୀଙ୍କ ମାଆଙ୍କ ଭାଇ 

C.  D. ସ୍ତ୍ରୀଙ୍କ ଭାଇ

D.  C. ସ୍ତ୍ରୀଙ୍କ ଭାଇଙ୍କ ପୁ ଅ

✓

Q92 Reasoning
In a certain code language, 'FOUR' is coded as '7542' and 'UNIT' is
coded as '1436'. What is the code for 'U' in the given code language?

A.  B. 1

B.  A. 2

C.  D. 3

D.  C. 4

✓

Q93 Reasoning
Which of the following letter-number clusters will replace the
question mark (?) in the given series to make it logically complete?
VQY43 UPX52 TOW61 SNV70 ?

A.  D. RMU79

B.  A. RMU78

C.  B. RMV79

D.  C. RMV78

✓

Q94 Reasoning
ଯଦି  '+' ଏବଂ '–' କୁ  ପରସ୍ପର ମଧ୍ୟରେ ଅଦଳବଦଳ କରାଯାଏ, ଏବଂ '×' ଏବଂ '÷' କୁ
ପରସ୍ପର ମଧ୍ୟରେ ଅଦଳବଦଳ କରାଯାଏ, ତେବେ ନି ମ୍ନ ଲି ଖି ତ ସମୀକରଣରେ ପ୍ର ଶ୍ନ  ଚି ହ୍ନ (?)
ସ୍ଥାନରେ କ'ଣ ଆସି ବ?

35 ÷ 3 + 81 × 9 − 8 = ?

A.  B. 101

B.  A. 104

C.  C. 110

D.  D. 125
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✓

Q95 Reasoning
B, C, D, E, G, H ଏବଂ I ପ୍ର ତ୍ୟେକଙ୍କର ସପ୍ତାହର ସୋମବାରରୁ  ଆରମ୍ଭ ହୋଇ ରବି ବାର
ପର୍ଯ୍ୟ ନ୍ତ ଏକ ଭି ନ୍ନ ଦି ନରେ ବି ମାନ ଯାତ୍ରା  ଅଛି  । G ପରେ କାହାର ବି ମାନ ଯାତ୍ରା  ନାହିଁ । H
ପୂ ର୍ବ ରୁ  ଯେକୌଣସି  ଗୋଟି ଏ ଦି ନରେ I ର ବି ମାନ ଯାତ୍ରା  ଅଛି  । B ଏବଂ D ମଧ୍ୟରେ କେବଳ
ଦୁ ଇ ଜଣଙ୍କର ବି ମାନ ଯାତ୍ରା  ଅଛି  । C ଏବଂ E ମଧ୍ୟରେ କେବଳ ଦୁ ଇ ଜଣଙ୍କର ବି ମାନ ଯାତ୍ରା
ଅଛି  । G ଏବଂ E ମଧ୍ୟରେ କେବଳ ଦୁ ଇ ଜଣଙ୍କର ବି ମାନ ଯାତ୍ରା  ଅଛି  । H ର ଠି କ ପରେ D
ର ବି ମାନ ଯାତ୍ରା  ଅଛି  । ମଙ୍ଗଳବାର କାହାର ବି ମାନ ଯାତ୍ରା  ଅଛି ?

A.  C. B

B.  D. C

C.  A. I

D.  B. E

✓

Q96 Reasoning
Select the pair which follows the same pattern as that followed by
the two set of pairs given below. Both pairs follow the same pattern.
NLP : LOR
DDV : BGX

A.  C. FHU : DKV

B.  B. OUT : MWV

C.  A. INF : GQH

D.  D. PIN : NLO

✓

Q97 Reasoning
P, Q, R, S, T, U and V are sitting in a straight line, facing the north. No
one sits to the right of S. Only three people sit between S and U.
Only two people sit between U and Q. R sits third to the left of P. T
sits to the immediate right of P. How many people sit between V and
Q?

A.  A. One

B.  D. Two

C.  C. Three

D.  B. Four

✓

Q98 Reasoning
Based on the English alphabetical order, three of the following four
letter-cluster pairs are alike in a certain way and thus form a group.
Which is the one that does not belong to that group?
(Note: The odd one out is not based on the number of
consonants/vowels or their position in the letter cluster.)

A.  A. IK-MP

B.  C. CE-GI

C.  D. KM-OQ

D.  B. MO-QS

✓

Q99 Reasoning
Read the given statements and conclusions carefully. Assuming that
the information given in the statements is true, even if it appears to
be at variance with commonly known facts, decide which of the
given conclusions logically follow(s) from the statements.

Statements: All jams are cobras. All cobras are mugs.
Conclusion (I): Some mugs are cobras.
Conclusion (II): All jams are mugs.

A.  C. Both conclusions (I) and (II) follow

B.  B. Neither conclusion (I) nor (II) follows

C.  D. Only conclusion (II) follows

D.  A. Only conclusion (I) follows

✓

Q100 Reasoning
ଶବ୍ଦ CONVERT ର ପ୍ର ତ୍ୟେକ ସ୍ୱରବର୍ଣ୍ଣ କୁ  ଇଂରାଜୀ ବର୍ଣ୍ଣ ମାଳା କ୍ର ମରେ ଏହାର ଠି କ
ପୂ ର୍ବ ବର୍ତ୍ତୀ  ଅକ୍ଷରରେ ପରି ବର୍ତ୍ତ ନ କରାଯାଏ ଏବଂ ପ୍ର ତ୍ୟେକ ବ୍ୟଞ୍ଜନ ବର୍ଣ୍ଣ କୁ  ଇଂରାଜୀ
ବର୍ଣ୍ଣ ମାଳା କ୍ର ମରେ ଏହାର ଠି କ ପରବର୍ତ୍ତୀ  ଅକ୍ଷରରେ ପରି ବର୍ତ୍ତ ନ କରାଯାଏ । ଏହି ପରି  ଗଠି ତ
ନୂ ତନ ଅକ୍ଷର ଗୋଷ୍ଠୀରେ ନି ମ୍ନ ଲି ଖି ତ କେଉଁ  ଅକ୍ଷର ବାମ ପାର୍ଶ୍ୱ ରୁ  ତୃ ତୀୟ ହେବ?

A.  B. O

B.  A. P

C.  D. M

D.  C. D
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